DK-5000 Series

WLAN MIERUZZO BASIC SOFTWARE

USER'S MANUAL

DK-5005A, DK-5010A, DK-5030A
DK-5005B, DK-5010B, DK-5030B
DK-5005C, DK-5010C, DK-5030C
DK-5005D, DK-5010D, DK-5030D

This manual was last revised March 07, 2017
*Contents are subject to change even without prior notice.
All Rights Reserved, Copyright © 2015, LINE SEIKI CO., LTD.






WLAN DK-5000 Mieruzzo Basic Software User’'s Manual

TABLE OF CONTENTS

SECTION 1 System Requirements
0 System Requirements 1
SECTION 2 Usage Instructions
1 WLAN DK-5000 Mieruzzo Basic Software and Driver 2
1.1  WLAN DK-5000 Mieruzzo Basic Software Installation
1.2  Mieruzzo Series Wireless/Sensor Device Driver 7
2 Connecting / Disconnecting a DK-5000 Device 9
2.1  Connect and Configure a Wireless Device 9
2.2  Connect a DK-5000 Device 15
2.2  Disconnect a DK-5000 Device 19
3 Data Communication with DK-5000 Device 21
3.1  Auto-Acquire Present Data 21
3.2  Acquire Present Data 24
3.3  Historical Count List 25
3.4  Acquire All Records 27
3.5 Delete a Specific Record 31
3.6  Clear All Records 33
3.7 Save Record from Software 34
4 Editing Labels 37
4.1  Edit Labels 37
4.2  Export Labels 39
4.3  Import Labels 40
5 Exporting Records to a File 41
5.1 Export a Specific Record 41
5.2  Export All Records 42
6 Changing Device Settings 44
6.1 Set Device ID 44
6.2  Synchronize DK-5000 Device Time with System Time 45
7 Miscellaneous Functions 46
7.1  View Device Firmware Version 46
7.2  Check for Software Updates 47

@5 LINE SEIKI




WLAN DK-5000 Mieruzzo Basic Software User's Manual

7.3  View Software Instruction Manual 48
7.4  View Software Version 48
SECTION 3 Frequently Asked Questions
8 Frequently Asked Questions 49

@2 LINE SEIKI m a



WLAN DK-5000 Mieruzzo Basic Software User's Manual

SYSTEM REQUIREMENTS

Below are the minimum system requirements to install and run the WLAN DK-5000
Mieruzzo Basic Software:

Processor Pentium 2 266MHz
Operating System Windows 7, 8, 8.1, 10
Disk Space Application: 50MB

Java Runtime Environment: 160MB

Memory 1GB

Microsoft Excel and Windows are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

=
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INSTALLING WLAN DK-5000 MIERUZZO BASIC SOFTWARE AND
DRIVER

1.1  WLAN DK-5000 MIERUZZO BASIC SOFTWARE INSTALLATION

1.1.1 Double-click or run the software installer.

_E WLAN DK-5000 Mieruzzo Basic
[ Software Setup Version 1.0 Build 3...
| WLAN DE-5000 Mieruzzo Basic So...

1.1.2 Select the language to use. Click OK to continue with the software installation.

‘Select Setup Langu
_E[ Select the language to use during the

i‘i\-‘-" installation:

|Engiish -

Ok ] I Cancel I

1.1.3 The WLAN DK-5000 Mieruzzo Basic Software Setup Wizard will start. Click Next to

continue with the software installation.

15! Setup - WLAN DK-5000 Mieruzzo Basic Software IS v o — o 5o

Welcome to the WLAN DK-5000
Mieruzzo Basic Software Setup
Wizard

This will install WLAM DE-5000 Mieruzzo Basic Software version
1.0 on your computer.,

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup,

Mext = ]I Cancel I

N
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1.1.4 Read the License Agreement and select ‘| accept the agreement’ to proceed.

Setup - WLAN DE-5000 Mieruzzo =
License Agreement

Flease read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

EMD-USER. LICENSE AGREEMEMT (EULA)

[ »

LIME SEIKI Co.,LTD.(Hereinafter referred to as "LIME SEIKI™) grants you the right

to install and use copies of the SOFTWARE PRODUCT (Hereinafter referred to as
"SOFTWARE™)

on your computer under following conditions,

1. COPYRIGHT

all title and intellectual property rights of SOFTWARE are owned by LINE SEIKI or
licensed

by suppliers, all rights of SOFTWARE are reserved by LIME SEIKI under applicable ™
@) I accept the agreement

(7)1 do not accept the agreement

< Back ]I Mext = I[ Cancel

1.1.5 Select the default installation folder or browse for a new location. Click Next to continue with
the software installation.

Setup - WLAN DE-5000 Mieruzzo =

Select Destination Location
Where should WLAM DE-5000 Mieruzzo Basic Software be installed?

Setup will install WLAN DE-5000 Mieruzzo Basic Software into the following
folder.

To continue, dick Mext. If yvou would like to select a different folder, dick Browse.

ieruzzoWWLAN DK-5000 Mieruzzo Basic Software Browse...

At least 161.2 MB of free disk space is required.

< Back ]I Mext = I[ Cancel
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1.1.6 Select the default location of program’s shortcut or browse for a new location. Click Next to

continue with the software installation.

Setup - WLAN DK-5000 Mieruzzo =

Select Start Menu Folder
Where should Setup place the program's shortouts?

| i Setup will create the program's shortouts in the following Start Menu folder.

To continue, dick Mext. If yvou would like to select a different folder, didk Browse.

LAN DK-5000 Mieruzzo Basic Software Browse...

< Back ]I Mext = I[ Cancel

1.1.7 Select whether to create or not to create a desktop icon for the software via the checkbox.

Click Next to continue with the software installation.

Setup - WLAN DE-5000 Mieruzzo =

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing WLAM
DK-5000 Mieruzzo Basic Software, then dick Mext.

Additional shortouts:
Create a desktop shortout

< Back ]I Mext = I[ Cancel
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1.1.8 Click Install to continue with the software installation.

Setup - WLAN DE-5000 Mieruzzo Basic Softwz

Ready to Install

Setup is now ready to begin installing WLAM DE-5000 Mieruzzo Basic Software on
your computer. -~

Click Install to continue with the installation, or didk Back if you want to review or
change any settings.

Destination location: p
C:\Program Files (x86)\Line Seiki\Mieruzzo WWLAMN DK-5000 Mieruzzo Basic Sof

Start Menu folder:
WLAM DK-5000 Mieruzzo Basic Software
Additional tasks:
Additional shortouts:
Create a desktop shortcut
4 Tl | 3

<Back || Instal | | cancel

A progress bar will show the installation progress.

Setup - WLAN DE-5000 Mieruzzo Basic Softwz

Installing

Flease wait while Setup installs WLAN DK-5000 Mieruzzo Basic Software on your
computer. -~

Extracting files...
C:\... \Line Seiki\Mieruzzo WYLAN DK-5000 Mieruzzo Basic Software'jreib\deploy.jar
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1.1.9 Wireless DK-5000 Series Device Driver Updater will open for the installation of necessary

device driver. Click Next to continue.

Wireless DK-5000 Series Device Driver Updater

Welcome to device installer.

your device.

To continue, click Mead.

Mexd =

This wizard will wallk you through updating the drivers for

Cancel

1.1.10 The following window will appear upon successful installation of the Wireless DK-5000

Series Device Driver. Click Finish to continue.

Wireless DK-5000 Series Device Driver Updater

Congratulations! You finished

device drivers.

came with instructions, please read them first.

installing your Wireless DK-5000

The drivers were successfully installed on this computer.

fou can now connect your device to this computer. F your device

Drriver Mame Status
%" Line Seiki Co., lid. www... Ready to use

Cancel
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1.1.11 Click Finish to complete the software installation. If Launch WLAN DK-5000 Mieruzzo Basic

Software is checked, the software will automatically launch.

Completing the WLAN DK-5000
Mieruzzo Basic Software Setup
Wizard

Setup has finished installing WLANM DE-5000 Mieruzzo Basic
Software on your computer. The application may be launched
by selecting the installed shaortouts,

Click Finish to exit Setup.

| Launch WLAN DK-5000 Mieruzzo Basic Software

1.1.12 See below image for the default view of the WLAN DK-5000 Mieruzzo Basic Software.

25 WLAN DK-5000 Mieruzzo Basic Software : 9000 = | G |
File Device Window Help
Auto-Acquire Acquire All Records /' Connection Export All Records

15:28:20 | Server Status: Running | Server Port: 9000

~

@5 LINE SEIKI




WLAN DK-5000 Mieruzzo Basic Software User's Manual

1.2 MIERUZZO SERIES WIRELESS/SENSON DEVICE DRIVER

1.2.1 The correct Mieruzzo Series Wireless/Sensor Device Driver is installed together with the

WLAN DK-5000 Mieruzzo Basic Software.

In case there is a need to re-install the device driver, it can be found by selecting the correct

driver located in the installation directory of the software.

e
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CONNECTING AND DISCONNECTING DEVICES

2.1 CONNECTING AND CONFIGURING A WIRELESS DEVICE

2.1.1 When a wireless device is physically connected to the computer via a USB cable, click

Window in the menu bar, then select Preferences (Window > Preferences)

-

=5 WLAN DK-5000 Mieruzzo Basic Software : 9000

File Device | Window | Help

Start Server Ctrl+5Shift+R
i, StopServer  Ctrl+Shift+0 Aci
Preferences  Ctrl+5Shift+P

%S

2.1.2 In the Device Configuration Preference, you will see a drop-down button that will list all

wireless devices that are currently connected with their type, ID Name, and COM Port

Connection. If there are multiple items in the list, select the device you want to connect.

=% Preferences O >

type filter text Device Configuration - - -

Device Configuration

Server Select available Mieruzzo Series Wireless/Sensor Device.

WLANT - Wi-408D : COM3 ¥ Refresh

Firmware Version View Details Connect

View Last Saved Configuration

2.1.3 Click Connect button to begin the configuration of the selected device.

2% Preferences Od >

type filter text Device Configuration - v v

Device Configuration

Server Select available Mieruzzo Series Wireless/5ensor Device.

WLANT - Wi-4090 : COM3 s Refresh

Firmware Version View Details Connect

View Last Saved Configuration
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2.1.4 A dialog will inform you if you successfully connected to the device. Otherwise, an error

message will display if the program can’t communicate to the device.

Connection Successful;
-E_*, nformation |

Successfully connected to the Mieruzzo Series Wireless/Sensor Device,

Connection Failure:

2 Error >

Unable to communicate to Mieruzzo Series Wireless/Sensor Device, Please check
device connection.

2.1.5 Once successfully connected to the wireless device, the Device Configuration will be
enabled for editing. You can now configure the device to connect to your wireless network.

Firmware version and View Details buttons will also be enabled.

a. Selecting Firmware Version button will show the current firmware and build number of

the wireless device.

[=31] - -
=y Firmware Version X

Mieruzzo Series Wireless/ Sensor Device firmware v.1.0 build 040
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b. Selecting View Details button will display the current configuration saved in the wireless
device. Select Load Config to load these data into their respective fields.

Device Configuration Details >

Connected Device;

WLANT - Wi-4090 : COM3

551D LIMESEIKIRHC
Authentication WPAZ
IP Addressing  dhcp

Host [P 0.0.0.0
Device IP 0.0.0.0
IP Mask 0.0.0.0
Gateway P 0.0.0.0
ID Mame Wi-4090

Destination Port 9000

Load Config Close

c. Device Configuration group: Input the required data to match with your network

settings.

Device Configuration

SSID | LINESEIKIRHQ |

Authentication WPRAZ

Paszphrase | sesssese |

IP Addressing DHCP

Host IP
Device [P
IP Mask

Gateway IP

ID Name | Wifi_Device_0001 |

Destination Port | 9959 |
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e SSID - the name of the network where the wireless device will connect.*

e Authentication — the network’s security. Select None if the SSID is an open
network.

e Passphrase — the network’s security key. It is disabled when you select None

from the Authentication field.*

o |IP Addressing — select from DHCP or static.

e Host IP, Device IP, IP Mask, Gateway IP — disabled when you select DHCP
since your router will automatically set these addresses. If you are using static
addressing, input the correct IP addresses corresponding to your network
settings.*

e |D Name — the name of the device.

e Destination port — value can be set from 0-65535. This is the same port that the
software server will use. Note that port 10000 cannot be used as well as some
other ports that the OS/other programs are using. Please be careful in selecting
the port you want to use.

* You may need assistance from your network administrator for these settings.

i. Select Set to set these values to the device.
a. If the value was correctly set the field will be colored green and red if there
is an error with the field. Insert the correct value and select Set again until
all required fields are green.

Device Configuration

5510

Authentication | WPAZ2

Passphrase

IP Addressing DHCP ~

Host IP
Device P
IP Mask

Gateway [P

D Marme

Destination Port
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Device Configuration

S50
Authentication |WPAZ
Passphrase

IP Addressing DHCP -~

Host [P

Device [P

IP Mask

Gateway P

I Mame

Destination Port

E Set ; | Save |

il. Once all settings are set, Save button will be enabled. Select it to save the
configuration in your device and in the application. Failure to save in a small
amount of time will require you to select Set again before being able to save
the current settings. A dialog will inform you if you're successful in saving
configuration.

Save successful: Restart device to apply changes.

2% Device Configuration Ed

Configuration saved. Please restart your Mieruzzo Series Wireless/Sensor Device for
these changes to take effect.

Save failed: Select Set again, then select Save once it’s active.

E"]- Error it

Module settings failed. Please set again and save within 5 seconds,

Error Code; 12
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Save failed: Device is disconnected. Reconnect the device and. Select Set
again, then select Save once it's active. Some values might have to be

reentered.

Unable to communicate to Mieruzzo Series Wireless/Sensor Device, Please check
device connection.

Error Code; 24

Upon successful configuration, the Preferences dialog will close and you can

now start the server for the configured device(s) to connect to the application.

d. Server Preference: Editing this setting will allow you to set a different port for your
server when it starts. By default, your server settings use the same value as the last
Destination Port (in Device Configuration) you saved. Note that you need to restart the

server if it is currently running. Also note that the reserved port numbers still apply.

-;E" Preferences l 5] éj
type filter text Server = v v
Device Configuration
T Server and port settings
Server Port 9000
Server Details
15:49:50 | Server Status: Running | Server Port: 9000 -

Select OK or Apply to save settings.

Restore Defaults Apply
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" .
= Information X

Server settings saved! Please restart the server for changes to take effect.

Upon success, the Preference page will close and a prompt will tell you to restart the
server.
Note that if your server is currently running, restarting the program is the only way for the

server to be restarted.

2.2 CONNECT A DK-5000 DEVICE

2.2.1 When a DK-5000 device is physically connected to the wireless device via a USB cable,

click Window in the menu bar, then select Start Server (Window > Start Server).

- —

;E, WLAN DE-5000 Mieruzzo Basic Software

File Device | Window | Help

o Start Server Ctrl+Shift+R
Stop Server  Ctrl+Shift+0
Preferences  Ctrl+5Shift+P

s

The status bar located in the lower left part of the application will display a message indicating that

the server has started using the specified port and is waiting for new connections.

15:52:18 | Server Status: Running | Server Port: 9000
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2.2.2 To check if a device has been discovered, click Device in the menu bar, then select

Connection (Device > Connection)

‘7|=£I WLAN DE-5000 Mieruzzo Basic Software : 8000

File | Device | Window Help
¢ Device Settings N —
ilf Connection Ctrl+ 0O
Disconnect Ctrl+Shift+C :
Sync Time Ctri+T
Edit Labels
Firrnware Wersion Ctrl+R

or click Connection button. You may also use the keyboard shortcut Ctrl + O.

gg'. WLAN DK-5000 Mieruzzo Basic Software : 9000 C=nne g

File Device Window Help

Auto-Acquire Acquire All Records  Connection Export All Records

2.2.3 The drop-down button will list all DK-5000 devices available with their corresponding Device

ID and IP Address. If there are multiple items in the list, select the device you want to connect.

Connection ot

Please select available DK-5000 device from the list.
DE-5010B - 246:192.168.1.126 -~

DE-530108 - 246 192.168.1.126
DK-50308 - 000 : 192.168.1.108
0] .4 | Lancel |
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2.2.4 Click OK to connect to the selected DK-5000 device.
When the software successfully connects to the selected device, the Title Bar will display the

Device ID, server port number and IP Address as shown below.

-

.;5, WLAN DE-5000 Mieruzzo Basic Software : 2000 - DK-50054 - 000 : 192.168.1.113

File Device Window Help

|l Auto-Acquire ‘ ‘ I! Acquire All Records

The device details will also be shown in the lower left corner which will show the device
model, Device ID, number of Records available in the device memory and wireless device
information.

Successful connection to a Type A or Type B device will show the Auto-Acquire page.

=)

File Device Window Help
|

1 Auto-Acquire ] I |1 Acquire All Records ] l 7/ Connection Export All Records

Auto-Acquire | Records |

Format1 | Format 2 | HCL Display|

Last Update Time: 2017-01-10 15:58:17

Model: DK-5005A | Device ID: 000 | Records: 7 | WLAN Infe - 1D Mame: Forlo | Server Port: 9000 | IP Address: 1821681113
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Successful connection to a Type C device will show the Acquire Present page.

File Device Window Help

I 1 Acquire Present Data | \ |1 Acquire All Records l l ¥ Connection l ‘ Export All Records

Present ‘

Last Update Time: 2017-01-10 15:58:22

Meodel: DK-5030C | Device ID: 001 | Records: 3 | WLAM Info - ID Mame: Forlo | Server Port: 9000 | IP Address: 192.168.1.113

File Device Window Help

I | Auto-Acquire l l |1 Acquire All Records l I / Connection I ‘ Export All Records
Auto-Acquire ‘

Status View | HCL Display

Last Update Time: 2017-01-10 16:01:30 M| standby (M High | Low

Model: DK-5030D | Device ID: 000 | Records: 1 | WLAM Info - ID Mame: Forlo | Server Port: 9000 | IP Address: 192.168.1.113
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2.2.5 |If attempting to connect a new device while there are Records from a different device on
display, a dialog will appear to confirm if Records will be saved before connecting to the new

device.

=% Connect New Device Ed

Your record will be cleared if you connect to a new device.,
Do you wish to save before you proceed?

es Mo Cancel

Select Yes to save the displayed Records.
Select No to discard the Records on display and continue connecting to the new device.
Select Cancel to abort connection to the new device.

2.2.6 In cases where no DK-5000 device is detected, an error message will be shown.

et

[z

Unable to detect a DE-3000 device, Please check device connection.

Error Code; 30

2.3 DISCONNECT A DK-5000 DEVICE

2.3.1 Click Device in the menu bar. And then select Disconnect (Device > Disconnect).

5 WLAN DK-5000 Mieruzzo Basic Software : 9001
File [Device | Window Help
~7 Device Settings » o
[ “ﬁl" Connection Ctrl+ QO
&7 Disconnect Ctrl+Shift+C
Aut i
gt SyncTime Ctrl+T
st = Edit Labels
Ls :@ Firrnware Version Ctrl+R

A message will appear to confirm disconnection. The DK-5000 was now successfully

disconnected from the server.
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=2 Safe to Remove Hardware X

| Device can now be safely rermnoved from your system.

Warning!

Do not physically disconnect the DK-5000 device from the wireless device without a
Disconnect command and confirmation that the device can be safely removed. This will
introduce a huge risk of the software not being able to detect re-connection of the DK-5000

device or new connections of new DK-5000 devices.
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DATA COMMUNICATION WITH DK-5000 DEVICE

3.1 AUTO-ACQUIRE PRESENT DATA

This function is available in Type A, Type B and Type D DK-5000 devices only. Software will
show the present data displayed on the DK-5000 device, and will automatically refresh every 1

second.

3.1.1 Click File in the menu bar, and then select Auto-Acquire (File > Auto-Acquire).

File | Device Window Help

Il Auto-Acquire Ctl+G
[lf|  Acquire All Records Ctrl+D

s Save Record Without Reset  Ctrl+Shift+T E
9= Save Record Ctrl+Shift+M =

Export All Records Ctrl+K L

iJ Exit Ctrl+X |
™

Or click Auto-Acguire button.

File Device Window Help
(|

1 Auto-Acquire ] l || Acquire All Records | l /¥ Connection Export All Records

3.1.2 A successful Auto-Acquire command will show the present data displayed on the DK-5000
device, and the display will be automatically updated every 1 second. The Last Update Time

of the display is also shown.

There are two display formats available. Click the corresponding tab/page to select the

preferred display format.

—
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Format 1 shows the individual values of each Inputs on the left side, and the total of all

Inputs on the right side.

File Device Window Help

| Auto-Acquire ‘ ‘ {1l Acquire All Records ‘ ‘ ¥ Connection I Export All Records

Auto-Acquire  Records

Format1 Format2 HCL Display

Last Update Time: 2016-10-04 16:45:58

Model: DK-5005A | Device ID: 000 | Records: 9 | WLAN Info - ID Name: Wi-409D | Server Port: 8000 | IP Address: 192.168.1.127

Format 2 shows the value of Input 1 on the left side, total and individual values of other

Inputs in the middle, and total of all Counter or Inputs on the right side.

File Device Window Help

I | Auto-Acquire l ‘ [l Acquire All Records ‘ ‘ / Connection ‘ I Export All Records

Auto-Acquire  Records

Format1 Format2 HCL Display

Last Update Time: 2016-10-04 16:47:24

Model: DK-5003A | Device ID: 000 | Records: 9 | WLAN Info - ID Name: Wi-409D | Server Port: 8000 | IP Address: 192.168.1.127
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For Type D, there is only one format for Auto-Acquire. A display legend is available to

determine the status of each Input. (Green = High, Red = Low and Blue = Stand by)

File Device Window Help

| Auto-Acquire ‘ ‘ |1l Acquire All Records ‘ ‘ 7/ Connection ‘ ‘ I5; Export All Records ‘

Auto-Acquire

€ | HCL Display

W standby (M| High B Low

Model: DK-5030D | Device ID: 999 | Records: 12 | WLAN Info - ID Name: Wi-409D | Server Port: 8000 | IP Address: 192.168.1.127
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3.2

3.2.1

3.2.2

ACQUIRE PRESENT DATA

This function is available in Type C DK-5000 devices only. Software will show the present
data displayed on the DK-5000 device.

Click Eile in the menu bar, and then select Acquire Present Data (File > Acquire Present
Data).

IIFlIe Device Window Help

Il Acquire Present Data Ctrl+G
[lf|  Acquire All Records Ctrl+D
= Start Record Ctrl+Shift+T
45 End Record Ctrl+Shift+M

Export All Records Ctrl+K
B Exit Ctrl+X

or click Acquire Present Data button.

| Acquire Present Data {{] Acquire All Records & Connection Export All Records

A successful Acquire Present Data command will show the present data displayed on the

DK-5000 device. Additionally, it will update the number of Records shown in the device
details.

AN DK-5000 Mie

File Device Window Help

l 1 Acquire Present Data l l |1 Acquire All Records l I ¥ Connection l | Export All Records |

Model: DK-5030C | Device ID: 001 | Records: 2 | WLAN Info - ID Name: ForLo | Server Port: 9000 | IP Address: 1921681113
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3.2.3 This function can be executed only when device is in Count Mode. If Acquire Present was

attempted while device is in Standby Mode, an error message will be shown.

=, Error b4

e

I{ ]I Device is on Standby Mode. Cannot display present data.

—

Error Code: 1

3.3 HISTORICAL COUNT LIST
This function is available for Type A, B and D DK-5000 devices. The software will show the
list of ongoing count values from DK-5000 device. The view will automatically take data from the

device every second for display according to user-set interval upon connection to the device.

3.3.1 To view the Historical Count List, click the HCL Display tab from the Auto Acquire view.

. =3 WLAN DK-5000 Mieruzzo Basic Software : 9

File Device Window Help

l | Auto-Acquire l l |1 Acquire All Records l l # Connection Export All Records

Auto-Acquire | Records ‘

| Update Time Total Inputl Input 2 Input 3 Input 4 Input
2017-01-10 16:11:18

7
2017-01-10 16:11:19 7
2017-01-10 16:11:20 7
2017-01-10 16:11:21 7
2017-01-10 16:11:22 7
2017-01-10 16:11:23 7
2017-01-10 16:11:24 7
2017-01-10 16:11:25 7

7

O A Y
Lo oWw oW W W W
oo o0 oo oo oo
o oo ocooo oo
o oo oo oooo

2017-01-10 16:11:26

T A I e

ﬁwmwmm&-wm»—t

< n | »

Update Interval HCL Data Export

At Ch @Ti s
Ad ange @ Time 1 ec Start 7] Auto Scroll

Model: DK-50054 | Device ID: 000 | Records: 7 | WLAN Info - ID Nare: Forlo | Server Port: 9000 | IP Address: 192.168.1.113
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3.3.2 To start populating the list, select the Interval Type, either At Change or Time. If Time is
selected, the user needs to input the value in the textbox and select the unit of time (sec, min
or hr) from the dropdown menu and then click Start button.

Update Interval

() At Change (®) Time sec | | Start | | Stop

Model: DK-50054 | Device |0z 000 | Records: 9 | WLAMN Info - 1D Mame: Wi-4(

3.3.3 The default Interval Type is set to At Change which means the table will update once
there is a change in the current value displayed in the DK-5000 device.

If At Change is selected, the textbox for time input and the dropdown menu for unit will be
automatically disabled.

Update Interval
(®) At Change () Time 1 sec Start | | Stop

Model: DK-50054 | Device |D: 000 | Records: 9 | WLAN Info - 1D Mame: Wi-409

3.3.4 To stop the table from updating, click Stop button.

Update Interval
At Change Time |1 SEC Start

Model: DK-50034 | Device |D: 000 | Records: 9 | WLAN Info - |0 Mame: Wi-40¢

3.3.5 By default the History Count List table is set to Auto Scroll. This feature allows the table to
automatically scroll to the latest table item. To enable and disable this feature, click Auto
Scroll checkbox.

Clear HCL Data Export

[] Aute Scroll

3.3.6 To clear the History Count List table, click Clear button.
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3.3.7 To export the table to Excel or CSV file, click the HCL Data Export button or right click on
the table and click HCL Data Export.

File Device Window Help

1 Auto-Acquire l l '] Acquire All Records l l /7 Connection Export All Records

Auto-Acquire | Records |

(|| | Format1 | Format 2 | HCL Display ‘

Update Time Total Inputl Input 2 Input 3 Input4 Input5 o
53 2017-01-1016:12:11 7 4 3 0 0 0
54 2017-01-1016:12:12 7 4 3 0 0 0
| 55 2017-01-10 16:12:13 7 4 3 0 0 0
56 2017-01-10 16:12:14 7 4 3 0 0 0
| ____
58 2017-01-1016:12:16 7 4 3 0 0 0
59 2017-01-1016:12:17 7 4 3 0 0 0
(| 60 2017-01-1016:12:18 7 4 3 0 0 0
61 2017-01-10 16:12:19 7 4 3 0 0 0
62 2017-01-1016:12:20 7 4 3 0 0 0
63 2017-01-1016:12:21 7 4 3 0 0 0
64 2017-01-10 16:12:22 7 4 3 0 0 0
65 2017-01-10 16:12:23 7 4 3 0 0 0
66 2017-01-10 16:12:24 7 4 3 0 0 0
67 2017-01-1016:12:25 7 4 3 0 0 0 W
68 2017-01-1016:12:26 7 4 3 0 0 0
69 2017-01-10 16:12:27 7 4 3 0 0 0
70 2017-01-10 16:12:28 7 4 3 0 0 0 2
n 2017-01-10 16:12:29 7 4 3 0 0 0
72 2017-01-1016:12:30 7 4 3 0 0 0
FE] 2017-01-10 16:12:31 7 4 3 0 0 0 -
| i |
Update Interval Clear | [HCL Date Export |
© At Change @ Time |1 S [7] Auto Scroll

Model: DK-5005A | Device ID: 000 | Records: 7 | WLAN Info - ID Name: Forlo | Server Port: 9000 | IP Address: 1921681113

3.4 ACQUIRE ALL RECORDS

This function enables the software to show all the records saved in the memory of DK-5000
devices. All Record details can be viewed and there is also an option to export Records to a

spreadsheet or delete a specific Record.

3.4.1 Click Eile in the menu bar, and then select Acquire All Records (File > Acquire All

Records).

.l[FiIe] Device Window Help

Il Auto-Acquire Ctrl+G
|lf|  Acquire All Records Ctrl+D
ey S5ave Record Without Reset  Ctrl+Shift+T
4= Save Record Ctrl+Shift+M

Export All Records Ctrl+K
8] Exit Ctrl+X
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Or click Acquire All Records button.

File Device Window Help

| Auto-Acquire ‘ ‘ |£] Acquire All Records ‘ ‘ 4 Connection Export All Records

3.4.2 A successful Acquire All Records command will show all the records saved in the memory of

the DK-5000 device. Additionally, it will update the number of Records shown in the
displayed device details.

For a Type A device, all Records are listed in a single table.

| File Device Window Help

1 Auto-Acquire ] l |1] Acquire All Records l l ¥ Connection l l |5 Export All Records

Auto-Acquire ‘ Records |

Timestamp Total Inputl Input 2 Input 3 Input 4 Input 5
1 2016-01-1205:34:24 0
2 2016-01-1205:35:14 O
3 2016-01-1205:35:20 O
4 2016-01-1205:49:19 0
5 2016-01-1205:58:45 0
[ 2016-01-1205:59:12 0

R T I

cocoocoo
cocoooao
cocoooo
cocoocoao
cocoooo

< 1 B

Model: DK-50054 | Device ID: 000 | Records: 7 | WLAN Info - 1D Name: Forlo | Server Port: 3000 | IP Address: 192.168.1.113
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For Type B, Type C and Type D devices, each Record is shown as a separate table. Each

table shows a list of all the logs inside that Record.

File Device Window Help I
{
| Auto-Acquire l l |11 Acquire All Records ] l 4 Connection l l IE) Export All Records
Auto-Acquire | 2016-01-01 01:05:57 | 2016-01-01 01:07:10 | 2016-01-01 01:24:06 | 2016-01-01 02:50:35 | 2016-01-01 02:50:46 | 2016-01-01 02:50:51 | 2016-01-01 02:50:55 | 2016-01-01( « | »
Timestamp Total Inputl Input 2 Input3 Input 4 Input5 Input 6 Input7 Input8 Input @ Input 10 Inpu
2 2016-01-01 02:05:57 O 0 0 0 0 0 0 0 0 0 0 0
a | [ | »
= Timestamp Total Inputl Input 2 Input3 Input 4 Input5 Input 6 Input7 Input8 Input @ Input 10 Inpu
1 2016-01-0101:05:33 0O 0 0 0 0 0 1] 0 1] 0 0 0
2 2016-01-0101:05:57 O 0 0 0 0 0 0 0 0 0 0 0
] I b
Start Time: 2016-01-01 01:05:39
End Time: 2016-01-01 01:05:57 E Export Record
MNumber of Logs: 2
Model: DK-50308 | Device ID: 000 | Records: 83 | WLAM Info - 1D Name: Forle | Server Port: 9000 | IP Address: 192.168.1.113

3.4.3 The software will display messages for three (3) conditions that indicate the status of

available memory on the device.

3.4.3.1 No Records In Memory
A warning message will be displayed to indicate that Acquire All Records is attempted but

there are no Records saved in the device memory.

=2 Warning oy

Ma record found.

Warning Code: 4
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3.4.3.2 Device Memory Low

“Memory Low” message will be displayed if device memory usage is between 80% - 100%.

== Information Ed

| Device mermaory is LOW.,

3.4.3.3 Device Memory Full

“Memory Full” message will be displayed if 100% of device memory is used. This serves as
a warning to backup data by exporting to an .XLS or .CSV file, and free up device memory
by deleting old Records. When memory is full, the device will automatically delete the oldest

Record to free up memory when additional memory for new Records is needed.

2% Information >

| Device memory is FULL.
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3.4.4 If Acquire All Records is pressed while the Records in the device are already on display

because of a prior Acquire All Records command, the software will check if there are new

Records or if there are changes in the device. If the Records in the device do not match the
Records on display, a dialog will appear to confirm if Records will be saved before acquiring

Records.

=% Update Record >

&% There are changes made in the device and you may lose some records if you update.

WY Do youwish to save before you proceed?

es Mo Cancel

Select Yes to save the displayed Records. Follow the export procedure.
Select No to discard the Records on display and continue acquiring new Records.
Select Cancel to abort acquiring all Records.

3.5 DELETE A SPECIFIC RECORD IN DK-5000 DEVICE

3.5.1 To delete a specific record in a Type A device, right-click on the Record to be deleted, and

then select Delete Record.

File Device Window Help
i

| Auto-Acquire l I 1] Acquire All Records ] l /¥ Connection l l I Export All Records ]

|Auto-Acqu|rE| Records ‘

Timestamp Total Input1 Input 2 Input 3 Input 4 Input 5
1 [oteorazosaee o JoJoJo o0
2 2016-01-12053514 0 0 0 0 0 0
3 2016-01-1205:35%:20 0 1] 0 0 a a
4 2016-01-1205:49:19 0 1] 0 0 a a
5 2016-01-1205:58:45 0 0 0 0 1} 1}
[ 2016-01-1205:58:12 0 0 0 0 0 0
7 2016-01-12 06:21:02 0 0 0 0 0 0

| m 3

Model: DK-5005A | Device ID: 000 | Records: 7 | WLAN Info - ID Name: Forlo | Server Port: 3000 | IP Address: 192.168.1113
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To delete a Record in Type B, Type C and Type D devices, right-click on the Tab Title of the

Record to be deleted, and then select Delete Record.

File Device Window Help f
i
| Auto-Acquire l l |4l Acquire All Records l I 7 Connection l I I Export All Records
| Auto-Acquire | 2016-01-01 01:05:57 | 201 01:24:06 | 2016-01-01 02:5035 | 2016-01-01 02:50:46 | 2016-01-01 02:50:51 | 2016-01-01 02:50:55 | 2016-01-01( * | *
& Delete Record
Timestamp Total Inputl Input 2 Input 3 Input 4 Input 5 Input & Input 7 Input & Input9 Input 10 Inpu
2 2016-01-01 01:07:10 0 0 0 0 a 0 0 0 0 0 a 0
| m I 2
: Timestamp Total Input1 Input 2 Input 3 Input 4 Input 5 Input & Input 7 Input 8 Input9 Input 10 Inpu
1 2016-01-0101:06:04 0O 0 0 0 1] 0 0 0 0 Q 1] 0
2 2016-01-01 01:07:10 0 0 0 0 0 0 0 0 0 0 0 0
« n (2
Start Time: 2016-01-01 01:06:04
End Time: 2016-01-01 01:07:10 E Export Record
MNumber of Logs: 2
Model: DK-5030B | Device ID: 000 | Records: 83 | WLAN Info - ID Name: Forlo | Server Port: 9000 | IP Address: 192.168.1.113

3.5.2 A dialog will appear to confirm the requested command.

2% Confirm b4

4% Are you sure you want to delete this record?

~ -

3.5.3 Click OK to delete selected record. The following message will appear to confirm that the

Record was successfully deleted.

L=
ot

@& Record was successfully deleted from the device.,

k- <
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3.5.4 Delete Record will not proceed if the Records in the device do not match the Records on
display. A dialog will appear to confirm if the display will be updated by an automatic

Acquire All Records command.

=% Cannot Delete Record Ed

. There are changes to the device records.
__I; Do you wish to update?

Select Yes to update display by acquiring all Records in the device memory.
Select No to abort Delete Record command.

3.6 CLEAR ALL DATA IN DK-5000 DEVICE

3.6.1 Click Device in the menu bar, select Device Settings, and then select Clear All Data

(Device > Device Settings > Clear All Data).

-
,i_q', WLAN DK-5000 Mieruzzo Basic Software : 9000 - DK-30054 - 000 : 192.168.1.1;
File [Device | Window Help
¢ Device Settings | [0 Clear All Data  Cirl+L
‘#-' Connection Ctrl+ 0O w4 SetDevicelD Ctrl+I
‘.-p*" Disconnect Ctrl+Shift+C 3
Aut et SyncTime Ctrl+T

|7 EditLabels
_:@ Firrnware Version Ctrl+FR Input 1 Input 2 Input

3.6.2 A dialog will appear to confirm deletion of all records.

=2 Clear All Data oy

Do you wish to clear all records in the device?
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3.6.3 Click OK to clear all Records in the device.
All the Records in the device will be deleted and the records displayed in the software will

also be cleared.

Note:
The DK-5000 device will proceed to Memory Recall Mode displaying “no data” to
indicate that the memory is cleared of all data.

3.6.4 For Type B, Type C and Type D devices, the Clear All Data feature cannot be used when
device is in Recording or Count Mode, respectively. If Clear All Data is attempted during
Recording or Count Mode, an error message will be shown.

| Device is on Recording mode, Cannot process your request.

Error Code: 5

3.7 SAVE RECORD FROM SOFTWARE

This feature allows the user to save the ongoing record to the device.

3.7.1 For Type A devices, there are two ways of saving a record. First is Save Record Without

Reset and the second is just Save Record. Save Record will reset the value on the device
upon saving. To save a record, select File from the menu bar and select which way you

want to save.

-

% WLAN DK-5000 Mieruzzo Basic Software : 9000 -

[File | Device Window Help
I Auto-Acquire Ctrl+G
bl Acquire All Records Ctrl+D
= Save Record Without Reset  Ctrl+5hift+T
4=] Save Record Ctrl+Shift+M
IF Export All Records Ctrl+K
8] Bt Ctrl+X

=
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3.7.2 For Type B, C and D devices, if the device is on Stand By mode, select File from menu bar
and select Start Record. Once the device is on recording mode and the user wants to save
the current record, go to File and select End Record.

& WLAN DK-5000 Mieruzzo Basic Software : 000 -
| File | Device Window Help
Il Auto-Acquire Ctrl+G
[lf|  Acquire All Records Ctrl+D
= Start Record Ctrl+5Shift+T
4= EndRecord Ctrl+Shift+M
Export All Records Ctrl+K
8] Bt Ctrl+X

Prompt that a record has been created.

=2 Start Record oy

Record Created

Prompt that a record has been saved.

=% End Record >

Record saved.

If the user tries to start a record while on recording mode, the software will prompt the user that the
device is on recording mode and cannot start a new one.

= Error >

Device is on Recording mode. Cannot process your request,

Error Code: 5

@ LINE SEIKI




WLAN DK-5000 Mieruzzo Basic Software User's Manual

If the user tries to start a record while on standby mode, the software will prompt the user that the
device is on standby mode and cannot start a new one.

== Error oy

Start Record is applicable only when device is on Standby mode.

Error Code; 16

If the user tries to end a record while on standby mode, the software will prompt the user that the

device is on standby mode and cannot end a non-existing record.

2 Error >

End/5ave Record is applicable only when device is on Recording mode or Count
mode

Error Code: 16
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EDITING LABELS

41 EDIT LABELS

This function allows the user to edit the default Input labels. These labels will be used in the

Auto-Acquire and Acquire All tabs when displaying data from the device and also in the exported

file.

4.1.1 To edit Input labels, click Device from the menu bar then select Edit Labels.

File | Device | Window Help

¢ Device Settings [
ﬂ' Connection Ctrl+ 0

‘j‘ Disconnect Ctrl+5hift+C

ey Sync Time Ctrl+T

Fc |5 Edit Labels
G@ Firrnmware Version Ctrl+R

4.1.2 The Labels dialog will be shown and the textbox for each label will be enabled depending on

the number of Inputs of the connected device.

Labels x
1 |Machine 1 ||| 2 [Machine2 || 3 [Machine3 || 4 |Machine4 I
6 || Inputé 7 Input 7 8 Input & 9 Input 9 10 || Input 10
11 || Input 11 12 || Input 12 13 | | Input 13 14 | | Input 14 15 || Input 13
16 || Input 16 17 || Input 17 18 | | Input 18 19 | | Input 19 20 || Input 20
21 || Input 21 22 || Input 22 23 | | Input 23 24 | | Input 24 23 || Input 25
26 | | Input 26 27 || Input 27 28 | | Input 28 29 | | Input 29 30 || Input30
Import | | Export Reset oK Cancel

In this example, the connected device has 5 Inputs.

Click OK button to apply the changes and Cancel button to discard the changes and close
the Labels dialog.

4.1.3 Upon applying the changes in Input labels, the Auto-Acquire and Acquire All Records view
will be updated.
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Auto-Acquire View:

File Device Window Help

[ 1 Auto-Acquire l l |1] Acquire All Records l | /¥ Connection I ‘ Export All Records

Auto-Acquire | Records |

I Format1 | Format 2 | HCL Display|

Last Update Time: 2017-01-10 16:3%:35

Model: DIG-5005A | Device ID: 000 | Records: 7 | WLAN Info - 1D Name: Forlo | Server Port: 9000 | IP Address: 192.168.1.113

Acquire All Records View:

l 1 Auto-Acquire | l | Acquire All Records | [ & Connection l l I Export All Records

|Au’la-Acqu|l=| Recerds |

Timestamp Total Machinel Machine2 Machine3 Machined Machine5
1 2016-01-1205:34:24 0 0 0 0 0 0
2 2016-01-1205:35:14 0 0 0 0 0 0
3 2016-01-1205:35:20 0 0 0 0 0 0
! 4 2016-01-1205:49:19 0 0 0 0 0 0
5 2016-01-1205:58:45 0 0 0 0 0 0
6 2016-01-1205:59:12 0 0 0 0 0 0
2016-01-12 06:21:

4 T 3

Model: DK-50054 | Device ID: 000 | Records: 7 | WLAM Info - ID Mame: ForLo | Server Port: 9000 | IP Address: 192168.1.113
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4.2 EXPORT LABELS

This allows the user to save the labels into a CSV file. This CSV file can be shared and

imported in case the user wants to use the labels again.

4.2.1 To export labels, open the Labels dialog. Go to Device from the menu bar then click Edit

Labels.

Labels 4
1 [ Machine T || 2 [Machinez 3 [ Machine3 || 4 | Machine4 [
6 | Inputf 7 Input 7 8 | Inputd 9 Input 9 10 || Input 10
11 || Input 11 12 | Input 12 13 | | Input 13 14 | | Input 14 15 || Input 15
16 || Input 16 17 || Input 17 18 | Input 18 19 | | Input 19 20 || Input 20
21 || Input 21 22 || Input 22 23 | | Input 23 24 | | Input 24 25 || Input 25
26 || Input 26 27 || Input 27 28 | | Input 28 29 | | Input 29 30 || Input30

Impert | | Export || Reset oK Cancel

4.2.2 After editing the labels, click Export button and the Save Dialog will show up with a default
file name ‘Input_Labels’. The user can change the file name then select the location and
click SAVE to save the CSV file.

2% Save As -
A < My Documents » DK5S000 v @ Search DK5000 P
Organize » Mew folder == = o
v [ This PC - Mame Date medified Type
I Desktop Mo iterns match your search,
> @ Documents
; Downloads
J‘& Music
| Pictures
B Videos
W WindowsT_05 (C)
>
File name: | Counter_Labels w
Save as type: | Comma-Separated Value (*.csv) ~
. Hide Folders Cancel
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4.3 IMPORT LABELS

Once the CSV file of the labels has been exported, the user can import it and use it
again.

4.3.1 To import labels, open the Labels dialog. Go to Device from the menu bar then click
Edit Labels.

4.3.2 Click Import button then select the CSV file and click Open. The labels from the CSV
file will be displayed in the Labels dialog.

£ Open x

= v » ThisPC » Documents » DE5000 v 0 Search DKS000 o

Organize » Mew folder =~ [ @

A - .
v [ This PC Mame Date modified Type

B Desktop @ Input_Labels 5/3/2016 3:00 PM Microsoft
» @ Documents
* Downloads
J) Music
| Pictures
g Videos
i Windows7_05 (C:)
3fBe286cObf3eleldfT
4DF1FFE16D6FOFBAFC » ¢ >

File name: |Input_Labels V| * 3V ~
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EXPORTING RECORDS TO A FILE
5.1 EXPORT A SPECIFIC RECORD

This function enables saving a copy of selected Record to a spreadsheet. This function is

available in Type B, Type C and Type D DK-5000 devices only. For Type A devices, please use the
Export All Records function.

5.1.1 To export a specific individual Record, right-click on the page to be exported, and then select

Export Record or click the Export Record button, which is found on the lower-right corner of
the page.

File Device Window Help

I Export All Records

| Auto-Acquire l I [£] Acquire All Records ] \ 4 Connection ] l
Auto-Acquire | 2016-01-01 01:05:57 | 2016-01-01 01:07:10 | 2016-01-01 01:24:06 | 2016-01-01 02:50:35 | 2016-01-01 02:50:46 | 2016-01-01 02:50:51 | 2016-01-01 02:50:55 | 2016-01-01( ¢ | »

Timestamp Total Machinel Machine2 Machine3 Machined Machine5 Inputé Input7 Inputd Input9 Input 10 Inpu
2 2016-01-01 01:05:57 0 0 0 0 0 0 a 0 0 0 0 a
4 1 | 3
= Timestamp Total Machinel Machine2 Machine3 Machined Machine5 Inputé Input7 Inputd Input 8 Input 10 Inpu
1 2016-01-0101:05:39 0 0 0 0 0 0 0 0 0 0 0 0
2 os-onoioiess7 oo Jo___J0 0 0 o Jo oo 0|

»
Start Time: 2016-01-01 01:05:38

End Time: 2016-01-01 01:05:57 E Export Record
MNumber of Logs: 2

| Model: DK-5030B | Device ID: 000 | Records: 83 | WLAM Info - 1D Name: Forlo | Server Port: 9000 | IP Address: 1921681113
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5.1.2 You can choose to save the record as an MS Excel Workbook (.XLS) or a comma separated
value (.CSV) file.

ﬁ‘. Save As e
&« v P » ThisPC » Desktop » DK 5000 v O Search DK 5000 2
Organize « Mew folder == - 0
& OneDrive ~ Mame Date modified Type 5iz
& OneDrive - Line 5 Mo iterms match your search.
[ This PC
[ Desktop
Documents
; Downloads
J’) Music
&= Pictures
E Videos v € =
File narme: | 102_20161005114951_20161005114958) “
Save as type: | Excel Workbook (*.xls) ~
~ Hide Folders Cancel

The default filename to be used follow the format below:
Device ID start timestamp end timestamp.xIs

Device ID start timestamp end timestamp.csv

5.2 EXPORT ALL RECORDS

5.2.1 To export all records displayed, click File in the menu bar, and then select Export All
Records (File > Export All Records).

| 2 Wi AN DK-5000 Mien.

File | Device Window Help

Il Auto-Acquire Ctrl+G
[lf|  Acquire All Records Ctrl+D
=g Start Record Ctrl+Shift+T
4= End Record Ctrl+Shift+M
5] Export All Records Ctrl+K
B8] Exit Ctrl+X
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Or click Export All Records button.

File Device Window Help

| Auto-Acquire L Acquire All Records 4 Connection IE Export All Records

5.2.2 You can choose to save the Records as an MS Excel Workbook (.XLS) or a comma
separated value (.CSV) file.

.ﬁ'. Save fs

= v A > ThisPC » Desktop » DK 35000 AN Search DK 5000 2

Organize - Mew folder A== 0

/& OneDrive " Name Date modified Type

#& OneDrive - Line Se Mo iterns match your search.

[ This PC
B Desktop

AL

=| Documents

; Downloads

J) Music

=/ Pictures

m Videos =

G102 20161005134203
Save as type: | Excel Workbook (*.xls)

» Hide Folders Cancel

The default filename to be used follow the format below:

Device ID date & time of export.xls

Device ID date & time of export.csv

If exported to Excel, each Record will be on a different sheet in one Excel file, while, if
exported in CSV, each Record will be stored as individual CSV files.
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CHANGING DEVICE SETTINGS

6.1 SET DEVICE ID

The software can be used to change the Device ID of the connected DK-5000 device. The

Device ID is a 3-digit user-programmable number which is used to identify different DK-5000

devices.

6.1.1 Click Device in the menu bar, select Device Settings, and then select Set Device ID

(Device > Device Settings > Set Device ID).

| \WLAN DK-5000 Mier

File | Device | Window Help
_» Device Settings b | [0 Clear All Data  Cirl+L

i
[ ﬁ Connection Ctrl+Q | g3 SetDevicelD Ctrl+I
‘ﬁi Disconnect Ctrl+Shift+C
lﬂ @ | Sync Time CtrleT 01:07:10 | 2016-01-01 01:24:06
|7 Edit Labels
G@ Firrnware Version Ctrl+R |
arhine1  Marhine 7 Blachin

6.1.2 Type the desired 3-digit Device ID.

Set Device D hod

Please enter the device 10

102

Cancel

6.1.3 Click OK to save selected Device ID.
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6.1.4 For Type B, Type C and Type D devices, this feature cannot be used when in Recording or
Count Mode, respectively. If the Device ID is attempted to be changed during Recording or

Count Mode, an error message will be shown.

= Error Ed
I{/ﬁ\]I Device is on Recording mode. Cannot process your request.

'\,\_\_'_'_/

Error Code: 5

6.2 SYNCHRONIZE DK-5000 DEVICE TIME WITH SYSTEM TIME

6.2.1 Click Device in the menu bar, and then select Sync Time (Device > Sync Time).

File | Device | Window Help
¢ Device Settings L
[ i,f" Connection Ctrl+ O
ﬂ.‘i Disconnect Ctrl+Shift+C
lﬂ LB Sync Time Ctrl+T
|7 Edit Labels
G@ Firrnware Version Ctrl+R

6.2.2 A dialog will appear that shows the current time of the PC.

Sync Time >

Tirne on device will be synced with time on computer,

2016-10-05 13:48:48

Cancel

6.2.3 Click OK to sync the time of DK-5000 device to system time.

-
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6.2.4 For Type B, Type C and Type D devices, this feature cannot be used when in Recording or
Count Mode, respectively. If time is attempted to be synced during Recording or Count

Mode, an error message will be shown.

= Error Ed

| Device is on Recording mode. Cannot process your request.

Error Code: 5

MISCELLANEOUS FUNCTIONS

7.1 VIEW DEVICE FIRMWARE VERSION

7.1.1 Click Device in the menu bar, and then select Firmware Version (Device > Firmware

Version). It will show the firmware version of the connected device.

[=31] - -
=5 Firmware Version X

| Mieruzrzo Series Wireless/ Sensor Device firmware v.1.0 build 040
D 5000 firmware w.11.4

-
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7.2 CHECK FOR SOFTWARE UPDATES

7.2.1 Click Help in the menu bar, and then select Check for Updates (Help > Check for Updates).

It will automatically search for available software updates.

£% Contacting Software Sites O >

Contacting Software Sites

[] Always run in background

Run in Background Cancel Details = »

If no updates are available, it will show a message prompt below.

=% Information >

Mo updates were found,

7.2.2 If there is no internet connection or if the software cannot connect to the update server, an

error message will appear.

F© N
=% Problem Occurred E@ﬂ

N h 'Contacting Software Sites' has encountered a problem.

" Unknown Host: http://software.line.com.ph/dk5000-release/repositony/content.xml

ok || Details>> |
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7.3

7.3.1

7.4

7.4.1

VIEW SOFTWARE INSTRUCTION MANUAL

Click Help in the menu bar, and then select Manual (Help > Manual). It will open a copy of

the WLAN DK-5000 Mieruzzo Basic Software User’s Manual.

VIEW SOFTWARE VERSION AND INSTALLATION DETAILS

Click Help in the menu bar, and then select About WLAN DK-5000 Mieruzzo Basic

Software (Help > About WLAN DK-5000 Mieruzzo Basic Software). It will show the following

window which tells the software build version and an option to see the software installation

details.
£ About WLAN DK-5000 Mieruzzo Basic Software IR
0 0 WLAMN DE-5000 Mieruzzo Basic Software
Version: 1.0.0.433
MIERUZZO
o von ,ﬂ. () 2016 Line Seiki Co., Ltd. Mieruzzo is a registered trademark of Line
———— Seiki Co., Ltd. All rights reserved, All other tradermarks or trade names
; I_ﬂ_ﬂ_ﬂ_ﬂ_ﬁ are properties of their respective owners.
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8 FREQUENTLY ASKED QUESTIONS

1. Why do | get a "no DK-5000 device detected" message when I click Connection even when my device is
visibly connected?

These are common reasons for not detecting a DK-5000 device, and possible solutions:

e Make sure your device is connected and turned ON. You cannot connect if the device is turned off.

e Make sure that the PC recognizes your device. If this is the first time you connected a DK-5000
device, it'll take some time for windows to install the appropriate driver. Please note that our
software installation contains the drivers necessary for your DK-5000.

e We received reports that changing the USB port to connect to help with the OS recognizing the

device.

2. Why do | get an "unknown device" error in device manager when | connect the wireless device to my
PC?
These are 2 possible reasons for unknown device error:
e Driver installation. Make sure that you've properly followed the software and driver installation.
e Windows USB Stack issue. This is an issue with Windows' USB stack. Try disconnecting then

reconnecting the device, or restarting your PC.

3. Why can’t | sync the time on my DK-5000 device to the PC time?
It is possible that your device is in Recording or Count Mode. There are restrictions to setting the time
when the device is not on Standby Mode (for Type B, C and D devices). Make sure you go to Standby Mode

first before syncing the time.

4. Why can’t | change the time on my DK-5000 device?
It is possible that your device is in Recording or Count Mode. There are restrictions to setting the
time when the device is not on standby mode (for Type A and B). Make sure you go to standby mode

first before setting the time.

5. Why can’t | change the Device ID on my DK-5000 device?
You cannot change the Device ID on your DK-5000 device if it is connected to the WLAN DK-5000

Mieruzzo Basic Software. Use the Set Device ID function of the software to change the Device ID.
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6. | already disconnected the device from the software, why can’t | change the Device ID on my DK-5000
device?

It is possible that your device is in Recording or Count Mode. There are restrictions to editing the

Device ID when the device is not on Standby Mode (for Type B, C and D devices). Make sure you go to

Standby Mode first before changing the Device ID.

7. Why are my old records missing in the device memory?
Your DK-5000 has limited memory and will erase the earliest record to free up space for new ones. To
avoid this, please refer to the manual and save your records using our WLAN DK-5000 Mieruzzo Basic

Software before clearing the device memory.

8. Why don’t | get back to the default folder DK-5000 when | export my records?
We have an initial folder DK-5000, but the software remembers the last folder where the user saved last
export. You may choose not to use the DK-5000 folder. But you should be able to find it again under your

Documents folder.

For more information, please visit www.lineseiki.com.
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